Using an Edline Gradebook
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Introduction

This guide will walk you through the setup and using an Edline Gradebook. It highlights web-
specific functions and differences between the web and network/local versions of the
gradebook. It is available from Gradebook in the Command Center at Edline or from
Gradebook on the toolbar. We suggest that you also read information accessed from the Help
menu in the gradebook. There you will find detailed descriptions of grading methods,
calculations, attendance, etc.

Setup

Follow these setup instructions the first time you use Edline web gradebiij on any computer:

Get the Gradebook Web Plugin

1. Login to Edline. You will see the Gradebook option in the Command Center or on the
top menu bar.

Wy Edline | Homé | Gradebook ] Help | Logout

Green Bay Primary School (BHS)

Home

My Classes &
Shortcuts

My Content

Account = ysssssssssssssssss -

COrTIrTIaI"Id IIIIIIIIIIIIIIIIII

Center Manage Schoal

Manage Design
Manage Users
Cluick Sync =

Privacy & Terms of Use
Help
About Edline

2. From the Gradebook menu, you will access your gradebook. If you do not see these
options, contact your school’s Gradebook Manager.

3. If you are new user of an Edline gradebook, click the Get Web Plugin option.

e Ata Windows computer, click Run to the prompt. Read and follow the prompts to
complete the download and installation of the plugin.
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e At a Macintosh computer:

0 GQWeb. Click Continue. Once the plugin image is downloaded, drag the blue
GQWeb icon to your Home Folder and double-click it to initialize the plugin.

0 EGP Web. Click OK in the dialog box that appears. Double-click the Installer
and follow the prompts.

4. Once you have the plugin, go back to the Gradebook menu at Edline, and click the
semester option to open your web gradebook.

If you receive any errors or are unable to successfully complete the installation, contact your
school’s Gradebook Manager or Super User.

Using Your Web Gradebook

1. Log in to Edline. If you are a teacher at multiple schools, go to the school page of the
school for which you want to use the gradebook.

2. Click Gradebook from the toolbar or from the Command Center.

3. Click your gradebook program. If more than one semester is visible on the Gradebook
menu, make sure you are using the correct semester for your task. It is important that
you select the correct semester, or your gradebooks will not be correctly updated.

4. The gradebook program will run, and all of your gradebooks will open. Your
gradebooks will contain up-to-date student roster information. When a new class is
created for you on Edline, a gradebook will automatically be created for it, and opened
with your other gradebooks.

Using the Web Gradebook on a Shared Computer

Windows: If you share a computer with other gradebook web users, and your
computer/network login does not have administrator or power user permissions, each user will
have to install the plugin. If you are not sure whether you need to install the plugin, click the
semester link. If the gradebook starts up, you do not have to install the plugin again. If you
receive a message that tells you to install the plugin, click Get Web Plugin and follow the
instructions to complete the setup.

Macintosh: If you share a computer with other gradebook web users, each user will have to
follow the setup steps above the first time they run gradebook web on that computer.

Updating the Web Gradebook Plugin

The web gradebook will update itself when a new version is available. When you run the
gradebook and an update is available, it will be downloaded and installed automatically. The
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web gradebook will open when the update completes. While updates are generally fast, some
may take several minutes, depending on the speed of your connection.

Syncing Your Gradebooks

All of your gradebook data, including setup and export data, will be automatically
synchronized to the web regularly. Unlike a network or local gradebook, you do not have to
"save" the gradebooks. When you exit the web gradebook, your final changes will be synced to
the web automatically. This insures that your most current gradebook information is always
available from any computer with Internet access, and that your exported grades and
attendance are available to your administrator to pull back in to your Student Information
System.

Gradebook Web Session Timeout

The web gradebook will sync your data to Edline every 4.5 minutes, if you have edited data
during that time. If you have the gradebook open and have not made edits to any of your
classes in about 70 minutes, you will be logged out. You will then be prompted to log in again
to continue working. Please note that your data will be saved to Edline prior to the timeout.
The only time that you will lose data that you entered is if you lose your Internet connection
while working in GradeQuick Web, so that GradeQuick is not able to access Edline to
synchronize the data. In this case, the most data you will ever lose is 4.5 minutes.

Managing Your Gradebooks

By default, on the web there is one gradebook per class. For many teachers, this represents the
gradebooks they need, and no additional gradebook management is necessary. However, there
are some cases in which you may want to create additional gradebooks, remove existing
gradebooks, or organize your gradebooks due to a semester transition. This can be done on the
web through gradebook management.

Managing gradebooks options

e Changing the Order of Classes. Gradebooks appear on the teacher’s page sorted
alphabetically by class name. The class name is the name you see in the Classes list.
Changing the name can also affect the order classes appear in GradeQuick Web.

e Copying from Other Gradebooks. An option in the web gradebook allows you to copy
from a gradebooks saved to the local computer or from a previous semester at Edline.

e Adding a New Gradebook. Creating multiple gradebooks for a single class. Its two
most common applications are elementary school classes that are not separately
scheduled by subject, and year-long classes on Edline that have separate gradebooks for
each semester.

e Uploading Existing Gradebooks. Uploading existing gradebooks from the network
version of GradeQuick into a class (including special case of network gradebooks Saved
to Edline).
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¢ Renaming a Gradebook. Gradebooks that were added or uploaded or automatically
created from rosters can be renamed.

¢ Deleting Gradebooks. If you added gradebooks you don’t want to use any longer, you
can delete them.

e Editing Gradebook Options. Here is a series of options you can set to omit gradebooks
from exporting, use with SiteReporter or change their semester assignment.

e Reverting to Previous Gradebooks. Using the Recycle Bin to restore a gradebook.

Changing the Order of Classes at Edline

The order of classes at Edline is alphabetical by class name. With the procedure below, you can
change the order.

1. Click Classes on the right side of your teacher page.
2. Sort the page by Teacher so your classes appear together.

3. Scroll the pages to find your classes.

SR EX MCHIP PGR 08-09_31 SE422_2 31 D. Arias Aug 17

MATH 1 08-09_31 MAT12X3_5 31 S. Armstrong Aug 17

MATH 1 08-09_51 MAT12X3_6 51 S. Armstrong Aug 17

STATISTICS 08-09_31 MAS51_2 31 S. Armstrang Aug 17
Ly LR e el Ll L TR P L L L L L
Edit 1-Teach. Assit. 08-09_31 TCHAST_110 31 E. Amold Today 1
Edit 2-AL GEBRAII 08-09_51 MAS11_2 81 E. Arnold Today 3
Edit -ALGEBRAI 08-09_31 MAS11_3 31 E. Arnold Today =
Edit 4-5R EX COOKBK 08-09_31 SE401_2 31 E. Arnold Today .
ENGLISH 10 08-09_51 EM121_3 51 J. Arundale Aug 17 E

sssnnnnnnnnfAlGiGHt i sssssnnnn e IS8 e s n e n e Fh@h R s s nlnbremdobs s s s s dum i o

4. Click the Edit button to access the class page.

woary

Class Information

--Ihh‘:-@lass‘\‘gl'rfcrasses""""""""---...-.

6‘ .‘
v, Class 1-Teach. Assit. o
L] - .
..qupg'. -Il"“
"Snmmnpy a sssssssmsuust®
Class ID: TCHAE"I'_‘HU'
C|ESS. . -- Font family -- v | --Fontsize - v | A - 3 By & gl HTmL
Description: i o
I UE=E=E= = = 7

Welcome to Teach. Assit..

5. Change the name. In this case, the names are changed so they sort in numbered order 1-
6.

6. Click Save.
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The picture below shows how the list of classes appears on the teacher’s page at Edline.

Yiew my classes & shortcuts

-

Yiewing Janet Baker's classes & shortcuts

1-ADVISORY GR 9-12 YR (XZAZ25005_01 51)
2-ALGEBRA 2 (MAX120051_01 51)
3-FRE-ALGEBRA (WxX905731_05 1)
4-PRE-ALGEBRA (M:<208751_02 51)
5-PROB SOLVING (M:rDO3251_02 51)
B-FROB SOLVING (WMxxD08351_03 S1)

Using *Gradebooks to Manage Gradebooks

The remaining gradebook management techniques are done from the *Gradebooks link. Your
Gradebook Manager will choose whether or not to allow you to use gradebook management. If
you do not see the *Gradebooks link under Contents on Edline, your administrator has
decided to hide this option. If you think you need to make any of these changes, talk to your
administrator about making this option available.

Accessing the *Gradebooks Folder

1. Log in to Edline. Select the class for which you want to create additional gradebooks
from the Classes & Shortcuts section on the left side of the page.

Green Bay Primary School (BHS)

Home

Wiew my classes & shortcuts

Janet's Classes
& Shortcuts

Iy Content
Account

Command
Center

-

Wiewing Janet Baker's classes & shortcuts

1-ADVISORY GR 9-12 YR (¥ZA25005_01 51)
2-ALGEBRA 2 (MAX120031_01 51)
3-PRE-ALGEBRA (M:x208751_05 51)
4-PRE-ALGEBRA (M:¥208751_02 51)
5-FPROB SOLYING (MX=D0B251_02 51)
B-FROB SOLVING (M:XxD0B551_03 S1)

=

2. On the class page, click the *Gradebooks link from the Contents section on the right
side of the page. If this option is not visible, your administrator has chosen not to make

it available to you.

4/16/2010

© 2010 Edline LLC, Chicago, IL, All Rights Reserved. [A-10]




Green Bay Primary School : Classes : 2.ALGEBRA 2

2-ALGEBRA 2 (MAX120081_01 W= sContents. ... =2
Home $1) . :

Janet's Classes
& Shortcuts

My Content
Account

Command Welcome to ALGEBRA 2.
Center

Adding a New Gradebook

In some cases, you will need more than one gradebook per class. Most commonly, this will

happen in these cases:
¢ In elementary schools, where classes may be scheduled for the whole day, but you want
separate gradebooks for each subject.

e When you have year-long classes on Edline, but want a separate gradebook for each
semester.

Note: If you will be sending grades or attendance data back to your Student Information
System, make sure that you only have one gradebook per class set to export, as you can only
send grades and attendance for one gradebook per class. This is particularly important if your
exports are sent automatically, or sent by your Gradebook Manager. See the section Editing
Gradebook Options below for information.

1. In the *Gradebooks folder, select New Gradebook and click Add.

A Select the fype 1o add.
Gradabaoks ot - ti—
{1-3of 3 items) Haw Gradahook w | Add Done
Saelactdll | Linselsct &)l Dlatads W Show 50
Hamea + Ma-difiad
E®| English ghi Today
Fuit UE LR Todsy
] [m] Sciencegbk Today
Salagiall | Unsslecil Detals |V Show 50 |
Manage Selected [tems 2 Ton
[ Delete |
| Done

A new gradebook will be created for you, named for the class and class ID.

Continue adding and naming gradebooks, until you have all the gradebooks you want
for this class. When you are finished, click Done, and repeat the process for your other
classes.
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“Gradebooks Select the tpe 10 80l

(14 of 4 inams) Mew Gradebook ~ | Add Dane
Select Al | Unselect Al Deetasls W | Show 50 | #
Hame ¢ Ml

M [Em English gk Today
Ed Math gk Taday
R Today

Today

Detadls ¥ | Show 50 &

Manage Selected ltems 10

[ Deleta |

Dong

Uploading Existing Gradebooks

If you have gradebooks that were created with the network/local version of your gradebook
software, that you want to upload into a class on Edline, you can do this for individual
gradebooks. Please note that gradebooks can be migrated so this step is not usually necessary.

If you are uploading a gradebook in order to copy settings you set up in a previously, see the
topic Copying from Gradebooks in a Previous Semester in this document.

1. Select Existing Gradebook and click Add.

2. You will be prompted to browse to locate the gradebook on your computer or network.
Select the local gradebook and click Add.

Green Bay Primary School : Classes : 2.ALGEBRA 2 : *Gradebooks
Add
Gradebooks Click "Browse" to specify the file to import (upload from your computer to Edline).

More Info
Al

3. The uploaded gradebook will appear in your gradebooks list for this class. Remember
that if this gradebook has a different set of students than those in the class, it will be
auto-updated to reflect the current roster for the class. All students in the gradebook
that do not match the membership of the class will be dropped and students in the
current membership will be added.

Note: 1f you saved gradebooks Edline from the local gradebook program, the latest version of
one or more of your gradebooks may be on Edline. You will need to retrieve these gradebooks
in order to use them with web. They will not automatically appear in your web gradebook.
Use the local gradebook software to download the gradebook before migrating it to Edline.
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Deleting Gradebooks

If you want to remove a gradebook and you will not need this gradebook again, you can delete
it. You can delete gradebooks that you created, or the default gradebooks that are created for
you.

1. Log in to Edline, select the class for which you want to delete gradebook(s), and click the
*Gradebooks link in the Contents section on the right side of the page.

2. Check-mark the gradebooks that you want to delete, and click Delete.

*Gradebooks Select the type to add.
(1-2 of 2 items) New Gradebook v
g A A : -
Eilljerﬁé;” | UnselectAll | Details ~ || Show 50 |»
Site
Name « Period Export Reporter Created [Modified
[ [Edit]| 2-algebra2-MAX120081_01.abk 09-10_81 Mo Yes Today 2010-04-08 10:08:37 COT
Edit | Algebraz-MAxX120051_01_04-02-10.abk 09-10_51  Yes Yes Apr2 2010-04-02 16:07:30 COT
SelectAll | Unselect All Details || Show 50
Manage Selected ltems €10
g Top
[ Copy To... ] [ Download... ] [Delete] [ Reorder... ]

3. You will be prompted to type the word “delete”, to insure that you intended to delete
the selected gradebook(s).

Explorer User Prompt

X
Senpt Prampk:

YWarhingl ¥'ou are about to delete gradebaook data. [F vow are sure yau want ta
proceed, type the ward 'delete’ below, Cancel

|delete

Your selected gradebook(s) will be removed from the list of gradebooks, and sent to the Recycle
Bin. To retrieve a deleted gradebook from the Recycle Bin, see instructions above for Using the
Recycle Bin to Restore Previous Gradebook.

Renaming a Gradebook

In the *Gradebooks folder, you can rename gradebooks created for you. To rename a
gradebook to something more personal, like spelling or math, or Algebra 2 Period 6, click the
Edit button next to the gradebook name, and change the Document Title.
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Editing Gradebook Options

The options that can be set are listed below. Click the Edit button next to the gradebook name
to access the following options.
1. In the *Gradebooks folder, click Edit next to a gradebook.

2. Change the options by adding or removing checkmarks. The options are explained in
the following paragraphs.

Gradebook Summary Information
Management
This gradebook is in *Gradebooks
Last Modified: 07/07/07
Gradebook Title: |AHealthTopics.gbk
Gradebook Summary:
Scheduling Period: | Semester 1 (Same as Class) ¥ | Wore Info
Pull exports {grades and/or attendance) from this gradebook.  Lore Info
[ Include this gradebook for SiteReporter.  More Info
These users can open and change this gradebook: Mare Info
ANGLIN, A
[ Save ] [ Cancel ]
Done £ @ Internet

¢ Scheduling Period. From this page, you can quickly change the scheduling period for
which this gradebook is associated. This option will only display for Year-Long classes.
If your school has year-long classes on Edline, but you have separate gradebooks for
each semester within the class, you can set the scheduling period for your gradebooks so
that only those from the current semester open in the gradebook.

e Pull exports (grades and/or attendance) from this gradebook. By default, this choice
will be checked. If you have multiple gradebooks for a class, you must indicate which
gradebook will be used for exports. This can be especially useful for year-long classes
whose class ID does not change and yet you wish to use a different gradebook per
semester. Remember that only one gradebook per class can be set to export.

¢ Include this gradebook for SiteReporter. If you have SiteReporter at your school, this
option will be checked by default. If you have extra gradebooks in your class that you
use for templates and do NOT want shown in SiteReporter, uncheck it.

e These users can open and change this gradebook. This will allow you to choose which
teacher can open and change a gradebook. In order for a teacher to appear on this list,
they must be added as a member of the class in Edline. See the topic Rules for Giving
More Than One Teacher Access to a Gradebook. If the gradebook is not used, such as
study hall or lunch or it is inactive, the check mark next to the teacher can be removed
and the gradebook will no longer open for the teacher.
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Rules for Giving More Than One Teacher Access to a Gradebook

Allowing more than one teacher to have access to a gradebook at one time will result in data
loss. For this reason, only one teacher should have access to a gradebook at one time.

If a class is actually taught by a different teacher than the one scheduled or you need for another
teacher to temporarily have access to a class, you can add the other teacher to the Class
Membership. In *Gradebooks—>Edit dialog, you can uncheck the scheduled teacher and check
the teacher who needs the gradebook. Only one teacher should be able to open the class or
there will be data loss even if one of the teachers does no work in the gradebook.

Using the Recycle Bin to Restore a Previous Gradebook

If you want to restore to the gradebook for the last day you used it (yesterday’s gradebook, if
you use your gradebooks daily), you can do so. The Recycle Bin holds previous gradebooks,
adding a gradebook once each day when you first make changes to it. For the first two
previous months, gradebooks could be saved daily. After two months, a gradebook is saved for
each week for two months. Previous to 4 months, one gradebook is saved for each month.
Gradebooks outside these parameters are no longer available for restoring.

1. Login to Edline, and select the class whose gradebook you want to restore from Classes
& Shortcuts.

2. Click the ~Recycle Bin link from the Contents section on the right side of the page. The
list of gradebooks in the recycle bin includes all gradebooks that you deleted, as well as
a previous copy of your current gradebooks. All gradebooks last the modify date and
time, so that you can select the correct version of a gradebook.

Contents =

3. Once you have found the gradebook you want to restore, check-mark the box next to it,
and click Restore. This gradebook will be placed back into the *Gradebooks folder
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T Ll k= Ll ) T
Green Bay Primary School : Classes : 2.ALGEBRA 2 : ~Recycle Bin
~Recycle Bin
(1-2 of 2 items)
SelectAll | Unselect All Show 50
Name Original Location Modified
O Algebra2 MAX120051 01.qbk *Gradebooks 2010-04-07 13:08:35 COT
O Algebra2 -MAX120051 01.abk *Gradebooks 2010-04-02 16:07:30 CDT
SelectAll | Unselect All Show 50 »
Manage Selected ltems € Top
IFTTTTTTTT
H .
= | Restore =
.

Move To ] [ Download

4. You will receive a message that the restore was successful. Click OK.
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GradeQuick Web

Changing the Order of Gradebooks in GradeQuick

Changing the class order for Edline will also change the order in GradeQuick’s Window menu.
See the topic Changing the Order of Classes at Edline.

The gradebooks appear on the Window menu in GradeQuick sorted alphabetically by their
name at Edline. The last gradebook opened appears on the spreadsheet when you enter
GradeQuick. You can change the order by renaming the gradebooks to sort so that the
gradebooks appear in an order that you prefer. If you want a particular gradebook to display
when GradeQuick opens, you may only need to make sure that the gradebook sorts to the
bottom of the list.

Mm Help

| 1 AdvisoryGro-12Yr-XZA25005_01,0bk (X2A25005_01)
2 2-algebraz-Max120051_01.gbk (MAX120051_01)
3 Pre-algebra-Mxx 905751 _05, gbk (MXX905751_05)
4 Pre-algebra-Mxx908751_02, gbk (MXX905751_02)
[ S ProbSolving-Mx905951_02.gbk (MXX908951_02)
® & ProbSalving-MEx905951_03.gbk (MX¥905951_03)

Handling More Than 30 Gradebooks

In some situations, teachers may be scheduled with more than 30 classes. GradeQuick Web
cannot open more than 30 gradebooks and will give an error message regarding this when it
runs.

The Gradebook Manager must create another user account for you and add you to the class
membership of your classes. When you activate the new account, do not combine it with your
old one.

The new user account will allow you to open all of your gradebooks by choosing up to 30 for
each teacher account. We suggest that you choose to open morning classes using one log in and
another set of classes with the second log in.

Use the process of changing the teacher that can open the gradebook for a class. Use
*Gradebooks=>Edit, uncheck one of the teacher names. This option is explained more fully in
the section Editing Gradebook Options.

Copying Gradebook Settings to Other Gradebooks

If you are starting new gradebooks and want to create global settings for all of those
gradebooks, you should set up your preferences in one gradebook and then use Gradebook to
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Gradebook Copy to copy to other gradebooks. If you were using Save Settings for this
purpose in GradeQuick Network, you will find that all options that were available in Save
Settings are now available in Gradebook to Gradebook Copy.

To use Gradebook to Gradebook Copy:
1. Log in to Edline, and click Semester x GradeQuick Web to run GradeQuick.

2. Choose one of your gradebooks as your template, and create all of your settings, such as
grade scales and attendance codes, in that gradebook. For instructions on setting all of
these options, see the Illustrated Roadmap on the GradeQuick Web Help menu.

3. Once all of your settings are complete in this gradebook, select Edit->Gradebook to
Gradebook Copy.

¢ Under Copy From, select the gradebook that you used for your settings.

e Under Copy To, select all other gradebooks to which you want to copy these settings.
To select multiple gradebooks, use ctrl+click.

e Under Copy What, select the item you want to copy, and make any relevant selections at
the bottom of the dialog.

Copy Grade Quick ltems @

Copy *hat..

Grade Symboals
Grade Scale

[ ata Field Mames
Attendance Codes
QuickNotes

Test Descriptions
Class Field Names
Student Roster
Score Footnotes
Lesson Plans

- Term Start Dates
Grading Preferences
‘Weights

Copy Fraom...

Algebral.gbk (1504 137]
Algebral.gbk [1504_458)
Leadership.gbk [1002_229)

V oK x ezl

4. Click OK.

5. Repeat this process for any other settings that you want to copy.

Posting Reports to Edline

You can easily create and send grade, attendance, and missing work reports in GradeQuick
Web. Customizing student progress reports for Edline uses the same procedure in the Print
Preview-Editor as printed student progress reports. Once you have customized the report to
display the information you want, instead of printing the report you will send the report to
Edline for students and parents to view online. When you post reports from GradeQuick, you
can send them from one class at a time or from several classes at once. Both methods are
described below.

1. Run GradeQuick Web.
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2.

Choose an Edline report by clicking the Post to Edline button on the toolbar, or Reports
—>Edline Reports.

&

Edline

If you click Post to Edline, you will be taken directly to the Student->Standard 1 Edline
Report.

If you click Reports=>Edline Reports, you can then choose any one of the six available
Edline reports. Only the Edline Reports can be posted to Edline.

You will see the Print Preview for the report you chose. In this window, you can customize and
format the report to include the information you want. See your GradeQuick Help or Help
menu for assistance formatting reports. You can change the content, but not the fonts, on Edline

reports.

Click the world icon on the Print Preview toolbar, or select Print=>Send to Edline. You
will see the Send to Edline Options dialog. Make your selection from the options below,
and then click OK.

Select Send Current Student to post a report for the current gradebook for only the
student who currently appears on the screen.

Select Send Selected Students of Current File to post a report for the current gradebook
for the students whom you have selected in the Print Preview.

Select Send All Students of Current File to post a report for the current gradebook for
all students in that gradebook.

Select Send Several Files to post a report for multiple gradebooks and students at once.
Steps 4-6 will explain the process of posting reports for multiple gradebooks at once.

If you are not sending several gradebooks, skip to step 7. If you are sending several
gradebooks, you will see an informational message that discusses how to select
individual tests. Because you are sending the report for several gradebooks, you will
not be able to select individual tests to send. You have two options to narrow the
selection of tests being sent:

To send tests for a specific term, you can choose the Single Term Only Edline report.

To send tests for a specific date range in the Print Preview, select Tests—>Select Tests
and Subtotals, and enter a date range in the Start Date and Stop Date fields in the lower
right corner.

Click OK on the informational message. You will see the Select Multiple GradeQuick
Files dialog. Choose the gradebooks you want to include.

Next you will see the Select Students dialog. All students from the selected gradebooks
will appear in the list. Click the Select All button to post the report for all students from
the selected gradebooks, or select students from the list.
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Note: If you have the same student in several files, that student will be listed multiple times,
and must be selected multiple times. A separate report will be posted for the student for each
class; GradeQuick will not create a single report for the student for all classes.

6. You will see the Edline Report Information dialog. Enter a description (or title) for this
report. The description entered here will appear as the title of the link to the report on
Edline, in the Contents section. If you are posting reports for multiple gradebooks, the
same description will be used for the reports from all gradebooks sent.

(0]

If you have already sent reports to Edline, all past reports names will be available
from the drop-down. You can select one of these to use the same name for your
report, or type a new name.

If you do re-use the same report name for the same class, then the previous
report that was posted to Edline will be replaced with the new version you are
currently posting.

If you use a different report name, then the previous report(s) will remain at
Edline until you remove it.

If you are posting progress reports regularly, you will probably want to use the
same name for reports, such as Current Grades, and have the most current report
replace the previous version.

7. Click Send This Report.

(0]

Wait for your browser to launch and bring up the Edline website. This may take
a minute or two, depending on the speed of your computer and Internet
connection. You will not have to log in to Edline.

You will get a status report telling you the number of reports sent. It will tell you
the number of reports added (i.e. sent for the first time), the number updated (i.e.
that overwrote an existing report for the student), and the number that had
errors. Below this you will see an explanation for each error that occurred (for
example a student ID might be incorrect). You should fix any errors and then re-
send reports for the students who had errors.

8. To see the reports you just posted, on Edline, select the class whose report you want to

see.

(0}

The report folder (named based on the description you assigned when you
posted the report), will be found in Contents on the class home page. Click the
folder name to open it.

You will see the name of each student for whom this report was sent from
GradeQuick. Click the student’s name to see the report. The report will look the
same as it did in the Print Preview in GradeQuick.

You will have the option to modify the contents of the report on the Edline site.
However, the changes that you make will not be transferred back to your
gradebooks. Therefore, if you want to make permanent changes to a student’s
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grade or other information, you should make those changes in GradeQuick, and
re-send the report.

Note: When students visit the class home page and click on the report, they will only see their
own reports; they will not see other students’ reports. Likewise, when parents click on the
report, they will only see reports for their own children.

Differences between GradeQuick Web and GradeQuick Network

All of the functionality of GradeQuick Web is identical to the functionality of GradeQuick
Network, with the few exceptions as explained in this document. Mostly, these exceptions
involve things that you no longer need to do, such as saving gradebooks, and check in/out of
gradebooks to work at home.

If you have been sending grades and/or attendance from GradeQuick back to your Student
Information System, you will still do what you did in GradeQuick Network to send those
grades or attendance. If you selected File->Send, you will do so in GradeQuick Web as well. If
your grades and attendance were sent automatically when files were saved, they will continue
to be sent that way. See your Gradebook Manager for instructions on sending grades and
attendance at your school.

Copying from Gradebooks in a Previous Semester

You can copy from a gradebook used in a previous semester or one saved locally.
e Windows. Use the Load Gradebook(s) option on the File menu in GradeQuick.

e Mac. Use Load Gradebook(s) available in the Gradebook to Gradebook Copy dialog.
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Choose from Hard Drive or from Previous Semester. You will receive this message. Click OK.

Information

- This Feature is intended ko be used For the purpose of Gradebook to Gradebook Copy. Gradebook will be
\l‘) opened in read-only mode.

Cancel
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e If you choose from Hard Drive, you will be present with a dialog box from which you
can browse to any location for which you have access.

e If you choose from Previous Semester, you will be asked to choose the semester you
want to access.

S5elect Period §|

Select the zcheduling penod you wish to wark, with

[~

]9

The gradebooks attached to that semester will open in Read Only mode.
e Windows. You will be able to see each gradebook as though it was a current gradebook.
It will appear that you can make changes but none of the changes will be saved when
you close the gradebook. You can also print reports from this gradebook.

e Mac. You will be able to copy from the loaded gradebook, not see or print from these
gradebooks.
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